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4.1.1 First Steps with Spreadsheets

What are Workbooks and Worksheets?
e You enter your data into a worksheet. It consists of rows and columns and is essentially
a very large table.

The worksheets in turn are grouped together into workbooks. By default each workbook
in Excel contains 3 worksheets, which are identified by tabs displayed along the bottom
of your screen, which identify the individual worksheets making up the workbook. By
default the first worksheet is called Sheetl, the next is Sheet2 and so on.

24
44 » M| Sheetl £ sheetz £ sheetz /

By default each new workbook you open will contain 3 blank worksheets, although you
can increase this number or reduce it down to a workbook, which only contains one
worksheet.

4.1.1.1 Open (and close) a spreadsheet application.

To start Excel using the Windows Start menu

e Click on the Start icon to display the Start menu and then move the mouse pointer onto
All Programs.

e From the sub-menu select Microsoft Excel.

To close Excel
e From the File menu, select Exit
OR press Alt+F4
OR click on the Excel Close icon (top-right of the Excel program window).

[E3

4.1.1.2 Open one, several spreadsheets.

To open an existing workbook
o From the File menu, choose Open
OR click on the Open icon on the Standard toolbar.
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e Locate the file which you wish to open and then double click on the file name to open it.
If you need to change to a different folder, then you can use the Up One Level icon
OR you can click on the down arrow next to the Look in field.

NOTE: By default the My Documents folder is displayed.

To select, and open a continuous block of files

e Click on the Open icon which will display the file Open dialog box. Click on the first file of
the block which you wish to select, and then while depressing the Shift key, click on the
last file of the required block. When you release the Shift key the entire block will remain

selected.
Z%
Look in: |D My Documents j @ ¥ » Tools =
My Data Sources
g’ éMy fusic
History ﬂMy Pictures
@cctglnhal-nl

@cctglubal-DZ
03

b

Fr ﬁ g
b ﬁcctglobal-ﬂ?

To select, and open, multiple files which are not in a continuous block
e Click on the Open icon which will display the file Open dialog box. Click on the first file
which you wish to select and while keeping the Ctrl key depressed, click on the other

files which you wish to select. When you release the Ctrl key, the selected files will
continue to be highlighted.

Loak in: |D My Documents j & X o ~ Tools -
My Data Sources
;&9 I ﬁMy Music
Histary @Mv Pictures

-] cebglobal-0t

cckglobal-07

4.1.1.3 Create a new spreadsheet (default template).

To create a new default workbook

e Click on the New icon located within the Standard toolbar
OR press Ctrl+N

4.1.1.4 Save a spreadsheet to a location on a drive.

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com



PAGE 6 - ECDL MODULE 4 (USING MICROSOFT EXCEL XP) - MANUAL

To save the workbook
e To save the workbook, click on the Save icon, and you will see the Save As dialog box.

Save As @
Savein: |D My Documents j @ (B - Tools *
My Data Sources
;Qé jMy Music
Histary @My Pictures
@cctg\oba\-m
@cctg\nha\-DZ
@cctg\oba\-US
My Documents @Eﬁtg‘ﬂhﬂ‘-m
@cctg\oba\fﬂs

T @:Etg\uba\-ﬂﬁ
@cctg\oba\fﬂ?

Desktop @contacts

@sales
=]
Favarites
=
.—__I...—'t' File name: j Save
My Mebwork =
Flaces Save as type: [Microsoft Excel torkbook | Cancel

¢ In the section of the dialog box called File Name, enter a name for your file. Then click
on the Save button to save the file.

4.1.1.5 Save a spreadsheet under another name.

To save a workbook (using a different name)

e Click on the File drop down menu and then select the Save As command. The Save As
dialog box will be displayed. If necessary select a different folder in which you may wish
to save the file.

o Enter the new file name in the File name text box.

e Click on the Save button.

To save afile to a diskette
e Click on the File drop down menu and select the Save As command. A dialog box will
be displayed similar to that illustrated.

Save in: |D Iy Documents j
My Daka Sources
:Qé j Iy Music

Histary uﬂ My Pictures
@ cekglobal-01
@ cckglobal-02
@ cchglobal-03
My Documents @ cckglobal-04
@ cekglobal-05

e Click on the down arrow to the right of the Save in section of the dialog box, which will
display a drop down menu, as illustrated.
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Save As
Save in: |E| My Documents - @ [ * Tools +
ﬂﬁ' Deskbop
:;9 aj My Computer
_,' [ shared Documents

Histary 314 Flappy

31 Py (A )]
=g Local Disk {C:)

@ @ DPPCPROOS00 (D:)
(=) CO Drive (E:)

o Select the 3 1/2 Floppy (A:) icon.
e Enter a file name and then click on the Save button.

4.1.1.6 Save a spreadsheet in another file type such as: text file, HTML,
template, software specific file extension, version number.

To save afile in a format other than Excel format, such as Lotus 123

e From the File drop down menu, click on the Save As command.

e If necessary, select the folder in which you wish to save the file from the Look in list box.

e Click on the down arrow to the right of the Save as type: box, and select the type of file
format in which you wish to save the file as, i.e. WKS, Excel 4 etc.

=
{:?—é‘ " .
File name:  [Bookl ] Save
My Metwork.
Places save as bype: |Microsoft Excel Workbook - Cancel

Microsoft Excel 97-2002 & 5.0/95 Workbook, j

S (Comnma delimited
Microsoft Excel 4.0 Worksheset
Microsoft Excel 3.0 Worksheet
Microsoft Excel 2,1 Worksheet
Microsoft Excel 4.0 Workbook A

o Enter afile name.
e Click on the Save button to save it in the required format.

To save afile in an earlier Excel format

e From the File drop down menu, click on the Save As command.

e If necessary, select the folder in which you wish to save the file in from the Look in list
box.

e Click on the down arrow to the right of the Save as type: box, and select the type of file
format you wish to save the file as, such as the example shown where we have selected
the Microsoft Excel 5.0/95 format.

=
gé File: narme: |Book1 j Save |
Iy Metwork,
Places Save as bype! |Microsoft Excel Workbook - Cancel |
Template :I
—

I
C5Y {Comma delimited)

e Enter a file name.
o Click on the Save button to save it in the required format.
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To save an Excel file as a text file
o From the File drop down menu, click on the Save As command.
e If necessary, select the folder in which you wish to save the file from the Look in list box.
¢ Click on the down arrow to the right of the Save as type: box, and select the type of text
format you wish to save the file as, such as Text (Tab delimitated)
My Network

Places Save as bype: |MicmsoFt Excel Workbook
web Archive

File: name: |Eookl

L

Save

Cancel

NI3K

ML Spreadsheet
|Template

Microsaft Excel 5.0/95 Workbook w2

If necessary, enter a file name.
e Click on the Save button to save it in the required format.

What are Templates?

e Frequently when working with spreadsheets you want to use the same layout or design.
You can re-create the design every time you want to use it, or you can create a
spreadsheet to use as a pattern. The spreadsheet pattern is called a template.

Templates can be produced which include the following elements:
- Text and graphics

- Formatting information

- Layouts

- Styles

- Headers and Footers

- Formulas

- Macros

o Templates are stored with the extension .XLT and when they are accessed to create a
new sheet, a copy of the original is made. The original template is left untouched ready
for further use. A template is produced by creating a spreadsheet which contains all the
elements you want, and then saving it as an .XLT file.

To save aworkbook as a template file

¢ You may save your workbook as an Excel template, by selecting Template from the
Save as type section of the Save dialog box.

=
gr= File name: |ngk1

Iy Metwark
Places Save as type! |MicrosoFt Excel Warkback

web Page
Wb archive

HML Spreadshest
Text (Tab delimited)
Unicode Texk -

L

Save

Cancel

LL» |«

To use a template
e From the File menu, select New to display the New dialog box.
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e Select the template you require. Notice that you normally see a number of tabs on this
dialog box, such as General and Spreadsheet Solutions. If you wish to use the default
template, select Workbook from the General tab.

e Select OK to open a copy of the template, i.e. a Workbook.

To save afile in a format suitable for posting on a Web site

e From the File drop down menu, click on the Save As command.

e Click on the down arrow to the right of the Save as type: box, and select the type of file
format you wish to save the file as, i.e.
Web Page (.htm:*.html)

= File name: k:
My Mlebwork. e |BOO ! = R

Places Save as bype: |M|crosaft Excel Workboak - Cancel
Microsoft Excel Workboak, -
web Archive

¥ML Spreadshest

Template

Text (Tab delimited) =

e Enter afile name.
e Click on the Save button to save it in the required format.

NOTE: Some formatting information which is contained in the original may be lost in the
process!

4.1.1.7 Switch between worksheets, open spreadsheets.

To switch to a different worksheet within a workbook
e Click on the required worksheet tab, displayed along the bottom of your screen, as
illustrated.

44 » M Sheetl £ sheetz £ sheetz /

To switch to a different, open workbook (using the Windows Status bar)
e Click on the required workbook icon, displayed within the Windows Status Bar, which is
along the bottom of your screen, as illustrated.

HEady

14 Start £ Biaoki 5l Bookz

To switch to a different, open workbook (using the Window drop down menu)
e Within Excel, click on the Window drop down menu, and you will see workbooks listed,
as illustrated (in this case Book1 and Book?2)
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————————
Window | Help

Hide

==

Freeze Panes

1 Book2 L

2 Bookl
¥

4.1.1.8 Use available Help functions.

What is the Office Assistant?
e By default this friendly little creature will watch what you do and offer tips on how to work
more productively.

Today's Tip

o By default Excel will display a tip of the day each time you start Excel. If you take the
time to read these when they are displayed, then you will soon find that you are on the
way to becoming an Excel expert!

BEH

-rIf you need help choosing a

function and entering its . _8 X
argurments, click the Insert -
b 100% Function button (the fic bution) on =
. Jthe Formula bar. =
M = New Workbook - X

DOpen a workbook

To display the Assistant

¢ If the assistant has been hidden you can reactivate it, select Show the Office Assistant
command from the Help menu. This will display a dialog box allowing you to ask
questions.

tindow | Help

Microsoft Excel Help F1 -
| Show the Office Assistant [:

o P g 7

K2 what's This? S+l | g

To hide the Assistant
¢ Right click on the Office Assistant, and from the pop-up menu displayed, select Hide.

maE

v

Options...

(Choose Assiskant... s

Open  Animate!
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To use 'what is this' Help within a dialog box

¢ Within many dialog boxes, you will see a question mark icon in the top-right of the dialog
box. For instance if you click on the Format drop down menu, and then select the Cells
command, it will display the Format Cells dialog box. If we wanted to know the purpose
of the Category options, you would click on the question mark icon, and then click on the
Category area of the dialog box. A popup box will be displayed, as illustrated, which
explains the function of the item you clicked on.

[2[]
Mumber lAIignment 1 Font. | Border ] Patterns | Protection |

Category: Sample
260

Click an option in the Category box, and then select [
the options that you want to specify a number format
The Sample box shows how selected cells will look
with the formatting you choose. Click Custorn ifyou
want to create your own custom farmats for
numbers, such as product codes.

at cells have no
ber Format,

Special

Custom J

4.1.1.9 Close a spreadsheet.

To close a spreadsheet
e From the File menu, select Close.

Microsoft Excel

! E Do you wank ko save the changes you made to ‘Bookl'?

Mo ‘ Cancel |

You will be asked if you wish to save any changes you have made to the file. Select Yes
to save, or No to ignore the changes.

If you are saving a new file, the Save As dialog box will be displayed. In the File name
text box, enter a name and click on the Save button.

4.1.2 Adjust Settings

4.1.2.1 Use magnification/zoom tool.
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To zoom the view
e Use the Zoom icon within the Standard Excel toolbar.

4.1.2.2 Display or hide built-in toolbars.

To display or hide a toolbar

e To display a toolbar, select the Toolbars command from the View menu to display the
Toolbars drop down menu. A list of toolbars is displayed.

e Choose the Toolbar you want to display by clicking on it from the list.

Standard
Formatting

- I

Contral Toolhm:

Forms

Formula Auditing
Ficture
FivotTable

Text To Speech
Visual Basic
Watch Window
Web

Wordart

Customize. ..

4.1.2.3 Freeze, unfreeze row and/or column titles.

To freeze panes

e To freeze a horizontal (column) heading, move the mouse pointer to the location indicated
and drag and drop to display one or more column.

Drag and drop
from here to split
the screen e
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e To freeze a vertical (row) heading, move the mouse pointer to the location indicated and
drag and drop to display one or more row.

rf_‘\
I n ] P

Drag and drop
from here to split
the screen

e From the Window menu, select Freeze Panes.

To unfreeze panes
¢ From the Window menu, choose Unfreeze Panes.

4.1.2.4 Modify basic options/preferences in the application: user name,
default directory/ folder to open, save spreadsheets.

To modify basic preference options
e Click on the Tools drop down menu and select the Options command, which will display
a dialog box. Click on the General tab.

Options

Colar ] International ]

View ] Calculation ] Edit | Transition ] Custom Lists ] Chart:
Settings

™ R1C1 reference style I~ Prompt For workbook properties

I Ignore other applications I Provide feedback with sound

IV Function tooltips ™ Zoom on roll with InteliMouse

¥ Recently used file list:  [4 3: entries Weh Options. ..

Sheets in new workbook: [ 3:

Standard font: |Arial j Size: |10 j

Default file location: |C:'|,D0cuments and Settings\David MurrayiMy Do

At startup, open all files in: |

User name: |David Murray

[o]4 | Cancel |

To set the user name: Enter your name in the User Name section of the dialog box.

To set the default directory: Enter the path to the directory which you wish to set up as
the default directory, in the Default file location section of the dialog box. Once applied
this default directory will be the one displayed in opening and saving dialog boxes within
Excel
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4.2.1 Insert Data

4.2.1.1 Enter anumber, a date, text in a cell.

To enter numbers

e Select the cell in which you want to enter a number and type in the number. If you want
to make the number a negative, type a minus sign in front of it or enclose it in
parentheses (i.e. brackets).

¢ To indicate decimal places, you type a full stop.

e The numbers will be right aligned by default. If you wish to enter a number or formula as
text, type an apostrophe before it.

To enter dates or times

e Select the cell in which you want to enter the date or time and then type in the date or
time. Separate the date with either hyphens or slashes.

e To enter the current date, press Ctrl+; to enter the current time, press Ctrl+:

To enter text into a cell
e Simply click on the cell and start typing the text which you wish to appear in that cell. To
move to the next cell use the Tab key. To move down a cell press the Enter key.

4.2.2 Select Cells

4.2.3.1 Select a cell, range of adjacent cells, range of non-adjacent cells,
entire worksheet.

To select a cell
e Click on the cell you wish to select.

To select non-adjacent cells

e Click on the first cell you wish to select.

o Depress the Control key.

e Click on the other cells which you wish to select.
e Release the Control key when you have finished.
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To
[ ]

select arange of cells by dragging the mouse

Click on the first cell in the range.

Hold down the left-hand mouse button and drag over the cells you wish to include in the
selection.

To

select a range of adjacent cells (making up a rectangular block)

Click on the first cell of the rectangular block which you wish to select (i.e. the top-left
hand corner).

Move down to the cell which marks the bottom-right corner of the rectangular block.
Depress the Shift key (and keep it depressed).

Click once on the last cell of the required block.

Release the Shift key.

To

select an entire worksheet
Click the Select All icon in the top, left-hand corner of the worksheet where the row
heading and column heading meet, or press Ctrl+A.

A [ B |

Click Here

To

select several worksheets
Click on the first sheet tab.
Click on other sheet tabs you wish to select whilst depressing the Ctrl key.

M} Sheet1 { Sheet2 f Sheetd f Sheetd f sheets {Sh

To

select all worksheets
Click on a sheet tab using the right-hand mouse button to display the shortcut menu.
Choose Select All Sheets.

Insert...
Delete

Rename

Move or Copy...

View Code

4.2.2.2 Select arow, range of adjacent rows, range of non-adjacent rows.

To

select arow
Click the row heading number.
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To select arange of adjacent rows

e Click the row heading number of the first row which you wish to select.

Position the mouse pointer at the last row in the range which you wish to select.
Depress the Shift key and keep it depressed.

Click on the last row in the range which you wish to select.

Release the Shift key.

To select arange of non-adjacent rows

Click the row heading number of the first row which you wish to select.

Position the mouse pointer at another row heading of a row which you wish to select.
Depress the Ctrl key and keep it depressed.

Click on further row heading numbers which you wish to select.

Release the Ctrl key. The selected row(s) will remain selected, as illustrated.

al-E~5

~l

4.2.2.3 Select a column, range of adjacent columns, range of non-
adjacent columns.

To select acolumn
o Click on the column-heading letter.

To select arange of adjacent columns

Click the column heading number of the first column which you wish to select.
Position the mouse button at the last column in the range which you wish to select.
Depress the Shift key and keep it depressed.

Click on the last column in the range which you wish to select.

Release the Shift key.

To select arange of non-adjacent columns
e Click the column heading number of the first column which you wish to select.

e Position the mouse button at another column heading of a column which you wish to
select.

o Depress the Control (Ctrl) key and keep it depressed.
e Click on further column heading numbers which you wish to select
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o Release the Control (Ctrl) key. The selected columns will remain selected, as illustrated.

4.2.3 Rows and Columns

4.2.3.1 Insert rows, columns in a worksheet.

To insert arow into a worksheet

¢ Select the row you want to move down when the new row is inserted above it.

e To select more than one row, drag the mouse pointer across the required row headings
(with the mouse button depressed).

¢ Right click over the selected row(s) to display a pop-up menu.
Select Insert. Any existing data will move down to accommodate the new rows.

To insert a column into a worksheet
e Select the column you want to move to the right when the new row is inserted.

e To select more than one column, drag the mouse pointer across the required column
headings (with the mouse button depressed).

¢ Right click over the selected column(s) to display a pop-up menu.
Select Insert. Any existing data will move right to accommodate the new columns.

4.2.3.2 Delete rows and columns in a worksheet

To delete a row or column
o Select the row(s) or column(s) you wish to delete.
¢ Right click on a selected row or column and choose Delete from the pop-up menu.

4.2.3.3 Modify column widths and row heights.

To change the width of a column

¢ Find the right-hand border of the column you wish to change and follow it to the top of the
worksheet into the area of the column heading.

¢ When the mouse pointer is moved in this area, it changes to a thick crosshair.

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com



PAGE 18 - ECDL MODULE 4 (USING MICROSOFT EXCEL XP) - MANUAL

Click on the right-hand column heading border and drag the mouse to the left to reduce

the column, or to the right to increase the column size.

NOTE: If you enter text which exceeds the column width, it will spill over into the next
column as long as the cell does not contain any data. If it contains data the entry will be

truncated at the edge of the cell. Although the entire entry does not appeatr, it will still be

intact. If you enter a number which exceeds the width of a column, ### signs will be
displayed in the cell to let you know that the column is not wide enough.

To

set the column width to match the data automatically

Find the right-hand column border in the column heading area.

Double click on the border to make the column change to fit the data in it. The column
will be as wide as the largest entry in it.

To

change the width of multiple columns to match the data

Click on the heading (column letter) of the first column you want to change, and drag to
highlight the other columns.

Double click on the right-hand border of the column heading of any of the highlighted
columns.

The column widths will change to match their largest entry.

To

set new default column widths

From the Format menu, choose Column Standard Width to display the Standard
Width dialog box.

Enter a new width for standard columns and click on OK.

To

change the height of arow

Select the row(s) you wish to change and from the Format menu, select Row and
choose Height from the Format Row menu. The Row Height dialog box is displayed.
Enter the value you want (from 0-409) in the Row Height text box. The value represents
the row height in points and click on OK.

To

automatically change a row height to match the data
Select the row(s) you wish to change and from the Format menu, select Row and
choose AutoFit from the Format Row menu.

4.2.4 Edit Data

4.2.4.1 Insert additional cell content, replace existing cell content.
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To insert additional cell contents, or to modify existing cell contents

e Click on the cell containing the data which you wish to change. In the example shown,
we have clicked on cell A2 containing the text Accounts for 2002.

Ed Microsoft Excel - Book1

File Edit Wew Insert Format  Tools Data  Window

hedam SRY FBR-C

4

arial vwvfg EEE=EEE
A2 - fe Accounts for 2002
A B G D E

2 |Accounis for 2002 _|

3

Let’'s say that we wanted to change the data in the selected cell from Accounts for 2002
to Accounts for 2003 There are two ways of doing this:

Method One: Click in the editing bar towards the top of your screen, where you will see
the contents of the selected cell displayed. Make your changes.

Method Two: Called 'in place editing'. Double click on the cell containing the data which
you wish to edit, and then edit the data directly within that cell.

To replace existing cell contents

e Click on the cell contents which you wish to replace. Type in the new data and the data
you enter will automatically replace the existing contents.

4.2.4.2 Use the undo, redo command.

To undo a command
e Click the Undo icon on the Standard toolbar

KT

OR select Undo from the Edit menu
OR press Ctrl+Z.

To redo a command
e Click the Redo icon on the Standard toolbar.

4.2.5 Duplicate, Move, Delete
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4.2.5.1 Duplicate the content of a cell, cell range within a worksheet,
between worksheets, between open spreadsheets.

To

copy a cell range within a worksheet
Select the cell (or cell range) which you wish to copy.

e Press Ctrl+C to copy the selected range to the Windows Clipboard.

e Click on the location where you wish to paste the copied data.

o Press Ctrl+V to paste the copied data.

To copy arow or column within a worksheet

e Select the row or column which you wish to copy.

o Press Ctrl+C to copy the selected range to the Windows Clipboard.

e Select the row or column where you wish to paste the copied data.

e Press Ctrl+V to paste the copied data.

To copy a cell range between worksheets

e Select the cell (or cell range) which you wish to copy.

o Press Ctrl+C to copy the selected range to the Windows Clipboard.

o Click on the worksheet tab (at the bottom of your screen), of the worksheet to which you
wish to copy.

e Click on the location where you wish to paste the copied data.

e Press Ctrl+V to paste the copied data.

To copy arow or column between worksheets

e Select the row or column which you wish to copy.

o Press Ctrl+C to copy the selected range to the Windows Clipboard.

¢ Click on the worksheet tab (at the bottom of your Excel screen), of the worksheet to
which you wish to copy.

e Select the row or column where you wish to paste the copied data.

e Press Ctrl+V to paste the copied data.

To copy a cell range from a worksheet in one workbook, to a worksheet in a

different workbook

Select the cell (or cell range) which you wish to copy.

Press Ctrl+C to copy the selected range to the Windows Clipboard.

Switch to (or open, or create) a second workbook.

Click on the worksheet tab to select the required worksheet within the second workbook.
Click on the location where you wish to paste the copied data.

Press Ctrl+V to paste the copied data.

To

copy arow or column from a worksheet in one workbook, to a worksheet in

a different workbook

Select the row or column which you wish to copy.
Press Ctrl+C to copy the selected range to the Windows Clipboard.
Switch to (or open, or create) a second workbook.
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e Click on the worksheet tab to select the required worksheet within the second workbook.
Click on the worksheet tab (at the bottom of your Excel screen), of the worksheet to
which you wish to copy.

e Select the row or column where you wish to paste the copied data.

e Press Ctrl+V to paste the copied data.

4.2.5.2 Use the autofill tool/copy handle tool to copy, increment data
entries.

To use AutoFill

o Enter a starting value for the series which you wish to create.

e Enter the second value in the next cell.

¢ Move the mouse pointer to the "fill handle" (this is the small black square at the bottom
right of the selected area). When the mouse pointer is over the fill handle, it will change
shape, from a large white cross to a small black cross.

e Depress the mouse button and drag as far as you wish to extend the range.

o When you release the mouse button the range will have been filled with incremental
values.

o Autofill can be used for number sequencing, days of the week, or months of the year.

Before using Autofill After using Autofill
A

e M-
|
>
| )
= :
L~ 0 W R
o o

—

ey
1 |Monday
2 |Tuesday

3 Wednesday
A4 |Thursday
5 |Friday
A B |Saturday
1 |Monday 7 |Sunday
2 Tuesday 8 |Monday
9

3 |
i 1.Tuest:lay

To see what AutoFill options are available

e Click on the Tools drop down menu and select the Options command. From the dialog
box displayed select the Custom Lists tab. You will see a number of pre-defined lists
displayed here.

NOTE: You could add your own custom lists using this dialog box.
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Options

Colaor ] International ] Save ] Error Checking ] Spelling ] Security ]

Wiew I Caleulation ] Edit ] General ] Transition  { ©

Custom lists: List entries:

Man, Tue, Wed, Thu, Fri, 3at, 5
Monday, Tuesday, Wednesday,
Jan, Feb, Mar, Apr, May, Jun, J

January, February, March, april

4.2.5.3 Move cell range contents, entire row(s), entire column(s) within a
worksheet, between worksheets, between open spreadsheets.

To move a cell range within a worksheet

e Select the cell (or cell range) which you wish to move.

Press Ctrl+X to move the selected range to the Windows Clipboard.
Click on the location where you wish to paste the copied data.
Press Ctrl+V to paste the copied data.

To move a row or column within a worksheet

e Select the row or column which you wish to move.

e Press Ctrl+X to move the selected range to the Windows Clipboard.
e Select the row or column where you wish to paste the copied data.
e Press Ctrl+V to paste the copied data.

To move a cell range between worksheets

e Select the cell (or cell range) which you wish to move.
Press Ctrl+X to move the selected range to the Windows Clipboard.

e Click on the worksheet tab (at the bottom of your screen), of the worksheet where you
wish to move.

e Click on the location to which you wish to paste the copied data.

e Press Ctrl+V to paste the copied data.

To move a row or column between worksheets
Select the row or column which you wish to move.

o Press Ctrl+X to move the selected range to the Windows Clipboard.
Click on the worksheet tab (at the bottom of your Excel screen),
of the worksheet to which you wish to move.

e Select the row or column where you wish to paste the copied data.
e Press Ctrl+V to paste the copied data.

To move a cell range from a worksheet in one workbook, to a worksheet in a
different workbook

e Select the cell (or cell range) which you wish to move.

e Press Ctrl+ X to move the selected range to the Windows Clipboard.
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e Switch to (or open, or create) a second workbook.
Click on the worksheet tab to select the required worksheet within the second workbook.
o Click on the worksheet tab (at the bottom of your screen), of the worksheet to which you
wish to move.
Click on the location where you wish to paste the copied data.
e Press Ctrl+V to paste the copied data.

To move arow or column from a worksheet in one workbook, to a worksheet in
a different workbook

e Select the row or column which you wish to move.

Press Ctrl+ X to move the selected range to the Windows Clipboard.

Switch to (or open, or create) a second workbook.

Click on the worksheet tab to select the required worksheet within the second workbook.

Click on the worksheet tab (at the bottom of your screen), of the worksheet to which you

wish to copy to.

Select the row or column where you wish to paste the copied data.

e Press Ctrl+V to paste the copied data.

4.2.5.4 Delete cell contents.

To delete the contents of a cell or range
e Select the cell or range which you want to delete.
o Press the Delete key.

NOTE: If you delete values from cells, which are used in formulas, the formulas will
return errors.

4.2.6 Search and Replace

4.2.6.1 Use the search command for specific content in a worksheet.

To find text in a worksheet
¢ Place the insertion point where you want to begin the search.

e Select the Find command from the Edit menu, or press Ctrl+F to display the Find dialog
box.
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e Type the text you wish to find in the Find what text box.

Find and Replace

Find l Replace ]

Findwhat: || |

Options ==
Find all | Find Mext | Close |

¢ Click on the Find Next button to find the next occurrence of the text you are looking for.

4.2.6.2 Use the replace command for specific content in a worksheet.

To find and replace text within a worksheet

¢ Place the insertion point where you want to begin the search.

e Select the Replace command from the Edit menu, or press Ctrl+H to display the Find
and Replace dialog box.

e Type the text you wish to find and replace in the Find what text box.

Find and Replace

Find Replace ]

Find what: ||

Replace with; |

[~
[~
Options >
Replace all | Replace | Find &ll | Find Mext | Close |

o Type the replacement text in the Replace with text box. Select from the following:
Find Next: Finds the next occurrence of the text.
Replace: Replaces this instance of the text.

Replace All: Will replace all occurrences of the text in the Find What section
with the text in the Replace With section.

e Select Cancel to stop the search or to close the dialog box.

4.2.7 Sort Data

4.2.7.1 Sort a cell range by one criterion in ascending, descending
numeric order, ascending, descending alphabetic order.
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To sort a list using the Sort icons
¢ Within your data, click within the column by which you wish to sort, then click on either the
Sort Ascending or Sort Descending icons.

Bz a3 E] B o

PN T oo | L= o=

+0 . ; 9 :
00+ Sort P.su:endlng|- Sort Descending|
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4.3.1 Handling Worksheets

4.3.1.1 Insert a new worksheet.

To insert a worksheet tab

¢ Right click on the worksheet which you wish to insert a new worksheet in front of. In this
case we have selected sheet two.

e From the popup menu displayed, select Insert, as illustrated.

25 | Insett.., |
2 Delete

27

28 Rename

29 Move or Copy...

=0 Select all Sheets

kil -

32 Tab Calar..,

33 View Code

1 4 v W] Shestl '’ Shetwroncsw

Ready

¢ You will see a dialog box displayed, click on the OK button.

Insert: |E”g|
General 1 Spreadsheet Solutions I
|OE 4 & b

Chart M5 Excel 4.0 International AT

Macro Macro Sheet

Worksheet

M5 Excel 5.0

Dialog
Preview nok available,

Cancel
The effect is illustrated below, where the new sheet four has been inserted before sheet
two.
el
32
33
W 4 » wmb Sheetl’ Sheetd { SheetZ / Sheets /
Ready

4.3.1.2 Rename a worksheet.
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To rename a worksheet tab

Right click on the worksheet tab which you wish to rename. From the popup menu
displayed select the Rename command.

23

24

25 Insert...

i Celete

ey

25 Rename

29 Move or Copy...
£ Select All Sheets
H

2 Tab Color...

3 & view Code

H 4 v » ]y Sheetl ) Sheerrraneserranees

Ready

You can then type over the default worksheet name, which will become highlighted.

W 4 v »y Sheetl b TEREL Sheet2 4 Sheet3 /

Ready

In this case the worksheet name Dave has been used.

J2
33

4 4 ¢ #]y Sheetl '’ Dave { Sheet2 / Sheet3 /
Ready

4.3.1.3 Delete a worksheet.

To delete a worksheet (by right-clicking)

Click on the relevant worksheet tab with the right-hand mouse button.
Select Delete from the popup menu displayed.

23

24

25 Insert...

26 Delete

2 n

25 Rename

29 Move or Copy...

a0 Select all Sheets

)

12 Tab Calar...

EE] &1 wiew Code L
4 « » W]y Sheetl Y Daversreetz 7 shEaE
eady

If the worksheet contains data, a warning dialog box is displayed. Select Delete to
continue.

Microsoft Excel

! E Data may exist in the sheetis) selected Far deletion. To permanently delete the data, press Delete.

Cancel
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4.3.1.4 Duplicate a worksheet within a spreadsheet or between open
spreadsheets.

To copy a worksheet within a workbook (the long way)
e Select the worksheet tab of the worksheet which you wish to copy.
¢ Right click on the worksheet tab, and select the Move or Copy command.

20
24

25 Insert. ..

L) Delete

27

75 Bename

29 | Mave or Copy...
30 Select All Sheets
H

32 Tab Color...

3 &1 Wiew Code

M 4 ¢ M\ Sheetl  Sheetz ;sneetay

Readv

A dialog box is displayed.

Move or. Copy E| PZ|

Move selected sheets
To book:

Bookz j

{move to end)

™ Create a copy

Ok | Cancel |

e Select (for example) move to end.
e Click on Create a copy. This will copy, rather than move.

Mowve or Copy

Move selected sheets
To book:

Biookz j

Before sheet:

e Click on the OK button. An example of the effect is illustrated below.

33
M 4 » wm] Sheetl { Sheet2 / Sheet3 ' Sheet2 (2) /
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To

copy a worksheet within a workbook (the quick way)
Select the worksheet tab, of the worksheet which you wish to copy.

o Depress the Ctrl key (and keep it depressed).

o Drag the worksheet tab, either left or right to the required position.
¢ Release the mouse button and then release the Ctrl key.

e A copy of the worksheet tab will be displayed.

To copy a worksheet to another workbook

Make sure that you have two workbook files open; the first containing a worksheet, which
you wish to copy to the second workbook.
Within the first workbook, select the worksheet tab, of the worksheet which you wish to

copy.
Right click on the worksheet tab, and select the Move or Copy command.

25 Insert...
26 Delete

Rename

29 | Move or Copy...

30 Select All Sheets

32 Tab Color...
33 &1 Wiew Code
M 4 » M\ Sheetl’ Sheetz =reera 7
Ready

A dialog box is displayed.
Click on the down arrow to the right of the To book section of the dialog box. Select the
name of the second workbook, (Book2, in the example illustrated).

Move or Copy E|E|

Maove selected sheets
To book:
|Book2 -
niew biook
Book3
|(m0ve to end) J
[7 Create a copy
(o4 | Cancel |

Click on the down arrow to the right of the Before Sheet section of the dialog box. Select
which worksheet you wish to insert the copy in front of.

Click on Create a copy.

Click on the OK button. An example of the effect is illustrated below (in this example we
choose to insert before worksheet 1)

a3
W 4 » m] Sheetl (2) 4 Sheetl { Sheet2 ' Sheet3 /
Ready

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com



PAGE 30 - ECDL MODULE 4 (USING MICROSOFT EXCEL XP) - MANUAL

4.3.1.5 Move a worksheet within a spreadsheet or between open
spreadsheets.

To

move a worksheet within a workbook (the long way)
Select the worksheet tab, of the worksheet which you wish to move.
Right click on the worksheet tab, and select the Move or Copy command.

25 Insert...
26 Delete

Rename

29 | Mave or Copy...

30 Select All Sheets
32 Tab Colar...

33 &1 Wiew Code
M 4 » M\ Sheetl’ Sheetz =reera 7
Ready

A dialog box is displayed.

Use the Before sheet section of the dialog box, to decide where to move the worksheet
to.

Make sure that the Create a copy is not selected.

Move or, Copy E| E|

Move selected sheets
To book:

|Book2 j

Sheet3
{move ko end) J

I Create a copy

Ok | Cancel |

Click on the OK button. An example of the effect is illustrated below. In the example
shown, Sheet 1 was moved to before Sheet 3.

|P |H|§ sheetz ) Sheetl [ sheets ?

To

move a worksheet within a workbook (the quick way)
Select the worksheet tab, of the worksheet which you wish to move.

Drag the worksheet tab either left or right to the required position. As you can see a
small, downwards pointing, arrow indicates where the worksheet will be moved to, when

you release the mouse button.

33
M 4 » »[\Sheetl / Sheet2 / Sheet3 /
Ready

Release the mouse button and the worksheet will be moved to the required location
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To move a worksheet to another workbook

Make sure that you have two workbook files open; the first containing a worksheet which
you wish to move to the second workbook.

Within the first workbook, select the worksheet tab, of the worksheet which you wish to
move.

Right click on the worksheet tab, and select the Move or Copy command.

20
24

25 Insert. ..

L) Delete

27

75 Bename

29 | Mowe or Copy...
30 Select All Sheets
H

32 Tab Color...

3 &1 Wiew Code

M 4 ¢ M\ Sheetl  Sheetz ;sneetay

Ready

A dialog box is displayed.
Click on the down arrow to the right of the To book section of the dialog box. Select the
name of the second workbook, (Book2, in the example illustrated).

Move or Copy E| g|

Move selected sheets
To book:

Book3 -
new book

Book3

| I

™ Create acopy

Ok | Cancel |

Click on the down arrow to the right of the Before Sheet section of the dialog box. Select
which worksheet you wish to insert the copy in front of.

Move or, Copy E| EI

Move selected sheets
To book:

Bookz j

Before sheet:

Sheet1 =]

Sheet2

{move to end)

™ Create a copy

oK | Cancel |

Make sure that the Create a copy option is not selected.
Click on the OK button.
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4.4.1 Arithmetic Formulas

4.4.1.1 Generate formulas using cell references and arithmetic operators
(addition, subtraction, multiplication, division).

To enter formulas into the worksheet cell

Place the cursor in the cell where the formula will appear.

Enter an = (equal) sign.

Enter the expression which will produce the result you want. This can consist of
operands, values, variables, and symbols which represent mathematical procedures such
as A5+ES5.

You can use the following symbols: -
+ to add

= to subtract
* to multiple
[ to divide

When the formula is complete, press Enter. The result of the formula will be calculated
and displayed in the cell.

You can display the formula itself in the Formula bar at the top of the screen by placing
the cell pointer on the cell.

If there is an error in a formula, an error message is displayed which will begin with a #
sign.

NOTE: If you cannot find an error in a function you can use the Paste Function to debug
it. Highlight the problem cell and click on the Paste Function icon on the formula bar or
Standard toolbar.

To enter a cell or range reference by pointing

Enter the formula up to the point of the cell or range reference, e.g. to enter the formula
=E2+ED5, only enter the equal (=) sign.

Move the cell pointer to the first cell reference using the arrow keys. The formula will track
your progress and enter the current address into the formula.

Press Enter to complete the formula when you have reached the cell you require.
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Operator evaluation order within Excel
¢ In Microsoft Excel operators are executed in this order:

AND, OR, NOT functions
+ or - (unary)
A

*or/

+ or -

&
=<><=>=<>

4.4.2.1 Recognise and understand standard error values associated with
using formulas.

Common formula error messages

o When writing formulas it is easy to make a mistake: listed below are some common error
messages.

HHHH

The contents of the cell cannot be displayed correctly as the column is too narrow.

#REF!

Indicates that a cell reference is invalid. This is often displayed when you delete cells
which are involved in a formula.

#NAME?
Excel does not recognise text contained within a formula.

On-line Help with formula error messages

e You can use the on-line Help to get further information about errors within formulas and
the meaning of the error messages.

¢ Click on the Microsoft Excel Help icon.
(2]
o When the Office Assistant is displayed, enter the phrase:-
correcting errors in formulas

and then click on the Search button.
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!What would you like to do?

® Display or hide formulas
% | ® about carrecting formulas

& { ® Find and correct errors in
for mulas

| ® WEB: Formulas il N (]
froubleshooter

Il

® ‘Worksheet functions listed
by categaory

¥ See more...

correcting errors in formulas|

Options Search

e Select "Find and correct errors in formulas".

o
What would you like to do?

© Find and correct errors in
formulas

© About correcting formulas

® Troubleshoot toolbars and
FAEFILES

® Designate valid cell enfries

® Troubleshoot converting

¢ You will then see the following displayed.

B Fle Edt Wew Imert Fomat Dok Data  Window Help

2 = e B 2

Dedan SRY &8 what would you like to do? '

Aial -0 E}g

" B sl ® Find and correct errors in 7
Ad T i formulas el
& E i B ® about correcting formulas = @ |

T o OE- = &

2 hihj ® Troubleshoot toolbars and

3 ghgh el Contents &nswerWizard | fndes | = Shows Al
[ ® Designate valid cell entries Find and correct errors in
5 What would you like to do? formulas

5 ® Troubleshoot canverting . |

file formats Formula errors can result in error walues

I a5 well a5 cause unintended resits.

8 ¥ See maore... Below are some tools to help find and
i investigate errors,
kil B Corvect an error value, such as

i) Select topic ba display: #NAME?

13 | | b \atch a Formula and result of a cell
13 | | Options Search P Calculate: 5 nested formuls one step
14 p at atime
15 P Trace the relationships between

15 formulas and cells
[z [ | | I P Correct comman prablems in formulas
18

19

il
21
e

23

24

25 Search op Web

%

27

e From this screen you can get detailed information about each type of error message.
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A Microsoft Excel Help

0 & & -

Cortents  Answer Wizard Ilndex |

= Show all

Find and correct errors in

what would vou like to do? formulas

Type your question here and then Formula errors can result in error values

click Search. a5 well as cause uninkended resulks,
Below are some tools ko help find and

investigate errors,

Search |
Lan grrar
# E

If a farmula cannat propetly
evaluate a resulk, Micrasaft Excel will
display an error value, Each error
tvpe has different causes, and
different solutions.

[ 2232
#VALUE!
#DIvj0!
#MAME?
#NiA
#REF!
#HLM!

Search on Web I HLILLY

P wiatch a Formula and result of a cell w

Select topic to display:

b
b
b
4
b
b

¢ Inthe example below we clicked on
boppae

Find and correct errors in
formulas

Formula errars can result in error values
as well as cause unintended results,
Below are some tools ko help find and
investigake errors,

w Correct an error walue, such as
#MAME?

If a Farmula cannaot properly
evaluate a result, Microsaft Excel wil
display an error value, Each error
type has different causes, and
different solutions.

Occurs when & column is not wide
enough, or a negative date ar kime
is used,

Review the possible causes and
solukions,
Possible causes and solutions

P Column is not wide enough to
display the content

P Dates and times are negative
numbers

4.4.2 Cell Referencing

4.4.2.1 Understand and use relative, mixed, absolute cell referencing in
formulas.
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What is relative addressing?

o By default Excel uses relative addressing. This means that when you use a formula the

components in the formula are relative. What does this mean? Consider the following
example:

E3 Microsoft Excel - Book2

Ele Edit Wwew Insert  Format  Tools  Data  window  Help

DeRan @RV BB o

4

@=-81% WPu -0,

Al -0 - B 7 UEEEE P %, WMEE E-D-A

021 - 2

A B © D E F

1 VAT Rate  17.50%
2
3
4
5 ltems Price (excluding VAT) VAT Price (including VAT)
6 | Laser printer 500 a87.5 5875
7 | Computer 900
8 Scanner 200
9
10

The VAT (Value Added Tax) rate is contained in cell F1.

In cell B6 is the price of a laser printer
In cell C6 is the formula =B6*F1
In cell D6 is the formula =B6+C6

If we used drag and drop techniques to highlight cells C6 and D6 and extend the formulas
down the page, we might expect this to work OK but it does not.

e To try this click on cells C6 and while keeping the Control key depressed click on cell D6.
Release the Control key and the two cells will remain selected.

B3 Microsoft Excel - Book2

File Edit  Wiew Insert  Formab  Tools  Data  Window  Help

DeEsH SRV $BE-C & = -8l i o -0,
i -0 - BZUSE=E T %, WM EE - -A-
CB v A =BE"F1
A B [ D [ E

1 VAT R:
2

3

4

5 ltems Price (excluding VAT) VAT Price {including VAT)
B |Laser printer 500] g7 5 5874

7 |Computer 900

g |Scanner 200

Move the mouse pointer to the fill handle, i.e. the small, square black dot at the bottom
right corner of the selected range.

Depress the mouse button and drag down for two rows, then release the mouse button.
If you look in cells C7 and C8 there is no VAT calculated!
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B3 Microsoft Excel - Book2

File Edit View Insert Format Tools Data ‘Window Help

DEESE SRV &B2R-T - % =z -2l &l e -3,
Arial -0 -|B I OEEEEHFwn, HNEEE-DA
CE - A =B6"F1
A B C D [ E
1 VAT |
2
3
4
5 ltems Price (excluding VAT) VAT Price (including VAT)
B |Laser printer 500 ar.a 5075
7 |Computer a00 0 a00
8 |Scanner 200 0 200
g =5
10

e Clicking on cell C7 gives the clue as to why this did not work. It contains a formula as

follows:
=B7*E2%

l.e. instead of picking up the VAT rate from cell E1, the formula is pointing to E2 (which is
blank).

- B T T T T VT —

c7 - A =B7"F2
A B ©

1

2

3

4

5 Items Price (excluding VAT) VAT Price (inc
B |Laser printer 200 7.5
| 7 [Computer s00| ol
8 |Scanner 200 0
[yl

This illustrates relative referencing: The referencing is using an X (i.e. right-left) and Y (i.e.
up-down) set of co-ordinates rather than an absolute addressing system, which would
always point to the contents of a particular cell.

What is absolute addressing?

Following on from the previous example, where relative references was used, we can fix
the problem by using an absolute address. Remember that we had a VAT percentage
amount in a cell, and when this was referenced in a relative manor while dragging and

dropping formulas, then the formula no longer worked. Again we will start with the
following:

Ed Microsoft Excel - Book2

Fle Edit View Insert Format  Toals  Data  Window  Help

DEeEdsE SBY LR o- @ x-2l i P -0
il 0B rUEE=EE T %, W EE A

D21 - £

A B c D E F

1 VAT Rate  17.50%
2
8
4
5 |ltems Price (excluding VAT) VAT Price (including VAT)
6 |Laser printer 500 g7.5 587.5
7 |Computer 900
8 |Scanner 200
9
10
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e The VAT (Value Added Tax) rate is contained in cell F1.

In cell B6 is the price of a laser printer
In cell C6 is the formula =B6*$F$1
In cell D6 is the formula =B6+C6

If we used drag and drop techniques to highlight cells C6 and D6 and extend the formulas
down the page, we might expect this to work OK and this time it does!

B4 Microsoft Excel - Book2

File Edt Mew Insert Format Tools Data  Mindow  Help

DeEdafn SEY & B & e @ = -2 Z] i 4 00 - )
arial w0 B ruUlEE=EE9 %, WN|EEE-D-A-
020 - Fe
A B C n] E F [

VAT Rate,  17.50%

ltems Price (excluding VAT) VAT Price (including VAT)
Laser printer 500 B7.5 5875
Computer 900 157.5 1057.5
Scanner 200 35 235

DOm0 M e W)=

e To try this click on cell C6 and while keeping the Control key depressed click on cell D6.
Release the Control key and the two cells will remain selected.

o Move the mouse pointer to the fill handle, i.e. the small, square black dot at the bottom
right corner of the selected range.

e Depress the mouse button and drag down for two rows, then release the mouse button.

As you can see to use absolute addressing, you prefix both parts of the cell address, by a
dollar ($) symbol.

NOTE: While entering formula into a worksheet you can use the F4 key to quickly convert
a relative cell reference to absolute, e.g. Select a cell and type =B4 and press the F4 key,
Excel will insert the dollar symbols for you.

4.4.3 Working with Functions

4.4.3.1 Generate formulas using sum, average, minimum, maximum,
count, functions.

What is a function?

¢ A function allows you to calculate a result such as summing numbers together, or finding
the average of a range of numbers.

Common functions
e Some commonly used functions include:

AVERAGE: Used to determine the average number of the selected cells.
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COLUMNS: Used to return the number of columns within a reference.
COUNT: Used to count how many numbers are in the list of arguments.
MAX: Used to return the maximum number from a list of arguments.

MIN: Used to return the minimum number from a list of arguments.

ROUND: Used to round off numbers to a specified number of decimal points.
SUM: Used to add the contents of selected cells.

Commonly used functions, as displayed when you click on the down arrow next to the
AutoSum icon.

E3 Microsoft Excel - Book4

File Edit Yiew Insert Format TJools Data  Window Help
DeEdam SRV | §BR-F o~ B(= -12) 2|l 45 100%
arial -0 - B I U = & %% 3um ]
H13 - e | Average |
A B G D

m

F Counk [ |
[Max

Min

M b L b —

More Functions. ..

To use the SUM function

e Select the cell you want to contain the sum formula. This is normally just under a column
of numbers, or just to the right of a row of numbers.

e Click the AutoSum icon on the Standard toolbar. Excel will create a sum formula, using
the range it thinks you want to sum.

=

¢ If the range is correct, press Enter. In the example shown, clicking on the AutoSum icon
produced the following =SUM(F3:F6). This means that the numbers within the cell range,
F3:F6 will be summed.

If Excel has not summed the correct range, then select the range you want to sum and
press Enter.

To use the AVERAGE function
e The AVERAGE function will display the average value for a range of numbers.
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Select the cell you want to contain the Average formula. This is normally just under a
column of numbers, or just to the right of a row of numbers.
Click on the down arrow next to the AutoSum icon and select the Average function.

LE -2 E

Surmn

| Average |

Count
Max

Min

More Functions...

In the example illustrated, the function has automatically selected the range D7:D10, and
will calculate the average value of the grades for English tests.

SUM X £ =AVERAGE(D?: D10}

A B C i} E F

1

2

3

4

5 SUBJECTS

B Name English History Art

7 Dave A0% 94% BE%

il Peter T4% 1% 45%

Ll Yvette 91% a7% E9%

10 Lou 4% 832% BE%
M Avergare grades :AVEHAGEFEEE

12 AVERAGE(numberl, [numberz], ...}

13

14

Press the Enter key to see the result.

To

use the MAX function

The MAX function will display the maximum number within a range.

Select the cell you want to contain the Max formula. This is normally just under a column
of numbers, or just to the right of a row of numbers.

Click on the down arrow next to the AutoSum icon and select the Max function.

|E -1 & i 4 o

Sum

fverage

T

Counk

[Max

Min

4 More Functions..,

In the example illustrated, the function has automatically selected the range D7:D10, and
will calculate the maximum value.
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E3 Microsoft Excel - av

File Edit Wew Insert Faormat Tools Data  Window Help

Voo# Ll z - H [
M- -4
SUM + X A =MAD7:DI0)
A B C D E F G
1
2
3
4
5 SUBJECTS
5 Name _E_n_g_lis_b_l History Art
7 Dave v UOBD% ' 84% 56%
] Peter L T4% B1% 45%
E] Yvette 3% ! BT% B3%
10 Lou L 54%_ 1 6%% 8%
11 Maximum grade|=MA
12 Max(number1, [numberz], .0 |
13
14

Press the Enter key and the result is displayed, as illustrated.

E3 Microsoft Excel - av

File Edit Wew Insert Format Tools [Data  Window Help

DeEST gRY FRR-I - % = -2 &l o -

arial -0 - B I U S=E=H9P %, WS EE @H-D-
F29 - F
A B © 0 E F G
1
2
3
4
5 SUBJECTS
5 Name English History Art
7 Dave B0% 54% 56%
g Peter 4% B1% 45%
9 Yvette 91% B7% B3%
10 Lou 54% B2% B8%
11 Maximum grade 9%
12

To use the MIN function

The MIN function will display the minimum number within a range.

Select the cell you want to contain the Min formula. This is normally just under a column
of numbers, or just to the right of a row of numbers.

Click on the down arrow next to the AutoSum icon and select the Min function.

= -8l 4 i o

Surmn

Average

Counk

Max

Min

d More Functions. ..

In the example illustrated, the function has automatically selected the range D7:D10, and
will calculate the minimum value.

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com



PAGE 42 - ECDL MODULE 4 (USING MICROSOFT EXCEL XP) - MANUAL

E3 Microsoft Excel - av

@ File Edit View Insert Format Tools Data  Wndow Help

| Lol z - 4%
.
sUM + X & =MND7:D10)
A B C D E F
1
2
3
4
5 SUBJECTS
53 Name Englishl History Art
7 Dave UGl 3 04% 56%
B Peter 4% U B1% 45%
9 Yvette i 01% . B7% B3%
10 Lou Lo B4% 1 % B88%
1 Minimum grade|=mMIN
12 %W\
17

o Press the Enter key and the result is displayed, as illustrated.

B3 Microsoft Excel - av.

File Edit wiew Insert Format Tools Data  Window Help

DEEaS8 SRAY BB - @ = -2 % W4 o

Arial -0 - B 7 U EEEHTF %, BN EEB@-
H22 - A

A B C n] E F
1
2
]
4
5 SUBJECTS
B Name English History Art
7 Dave G0% 94% E6%
g Peter T4% 1% 45%
9 Yvette 9% 87% B9%
10 Lou 54% 82% BE%
11 Minimum grade 54%
12

To use the COUNT function
e The COUNT function will count up the number of cells which contain numbers.

¢ Inthe example illustrated, we have an attendance register, where people are marked as
present or absent.

E3 Microsoft Excel - Book5

Ele Edit Miew Insert Format  Tools  Data  Window Help

DFEdaSy SRV &6 <o - w = -2 i
Arial w0 -B U SEEEBEF %, @8 ss
D15 ~ f
A B C D E

1

2

3 ATTENDANCE
4 Name Present Not Present

5 Dave 1

B Sue 1

7 James 1

] Lou 1

9 Fiona 1

10 Yvette 1

1 Rowan 1

12 Elliot 1

13 Malcolm 1

14 Graham 1
15| Total

16

e To list the number of people present using the Count function , we first need to click on
the cell you want to contain the Count formula, i.e. cell D15.
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e Click on the down arrow next to the AutoSum icon and select the Count function.

= |84 3| il B 1o
Sum 4

fverage

| Counk |_

[ax
Min

More Functions..,

e As you will see in this case the function has not selected the range which includes all the
names, but only the two names in the range D13:D14. The reason for this is the gap in
the column of numbers in cell D12.

E3 Microsoft Excel - Book5

Elle Edt \iew Insert Format Tools Data  Window Help

T H BB o -
SUM = X A =COUNTD13:014)
A B C D E f

1

2

3 ATTENDANCE
4 Name Present Not Present
5 Dave 1

5 Sue 1

7 James 1

] Lou 1

9 Fiona 1

10 Yvette 1

11 Rowan 1

12 Elliot 1

13 Malcolm

14 Graham
|15

16 COUNT{valuel, [valusZ], ...}

17

e We need to manually select the range D5:D14, as illustrated.

E3 Microsoft Excel - Book

@ Ele Edit Yiew Insert Format Tools Data Window Help

Vi = © = -
SUM + X o A =COUNTDS:D14)
A 5] [ D E f
1
2
3 ATTENDANCE
4 Name L__P_rg_s_e_n_t_ J Not Present
5 Dave 1 1 I
B Sue | 1 ]
7 James \ i 1
g Lou | 1 |
9 Fiona | 1 |
10 Yvette | 1 |
1 Rowan \ 1 |
12 Elliot ' j 1
13 Malcolm \ 1 |
14 Graham | ‘I_____i
115 =COUNT(DS.D14)
16 CoOUNT(valuel, [valusz], ..}
17

o Press the Enter key and the result is displayed, as illustrated.
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E3 Microsoft Excel - Book5

File Edit VYiew Insert Format Tools Data  Window Help

a8 &RV $B2R-F - & z-8 i
taial -w -[Blru ESEE8 9%, W%
D15 - A =COUNT(DS:D14)
A B [ D E
1
2
3 ATTENDANCE
4 Name Present Not Present
5] Dave 1
B Sue 1
7 James 1
8 Lou 1
g Fiona 1
10 Yvette 1
1 Rowan 1
12 Elliot 1
13 Malcolm 1
14 Graham 1
ﬂ Total 8
16
17

NOTE: We can use the same technique to display the number of persons not present in
cell E15.

4.4.3.2 Generate formulas using the logical function if (yielding one of
two specified values)

The IF Function

Excel has a number of functions which allow us to evaluate values and make decisions
based on the result of the evaluation. The IF() Function is one of these.

IF() Syntax
The format (Syntax) of the IF() function is as follows:
IF(Logical_test, Action_if_true, Action_if false)

Logical_test
The logical_test evaluates an expression to see if it passes the test, i.e. is TRUE or does
not pass the test, i.e. is FALSE

Logical Values for Evaluation Result
operators A=10 B=5
C=15 D=10
= (Equal to) A=B FALSE
A=D TRUE
> (Greater than) A>B TRUE
A>C FALSE
< (Less than) A<B FALSE
A<C TRUE
>= (Greater than or Equal | A>=B TRUE
to)
A>=D TRUE
A>=C FALSE
<= (Less than or Equalto) | A<=B FALSE
A<=C TRUE
A<=D TRUE

Action_if_true
Action_if_true can be a value or an operation. Whichever, the result is placed in the cell
which contains the IF( ) Function if the logical_test is true.
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Action_if_false
Action_if_false can be a value or an operation. Whichever, the result is placed in the cell
which contains the IF() Function if the logical_test is false.

To enter an IF() function

e Click on the cell to contain the IF() function.

e Click on the down arrow next to the AutoSum icon, and from the menu displayed select
More Functions, as illustrated.

Z -|¢] Zl il 4 Lo
Surn
fverage
Count
Max

Min

| More Funckions.. . |

e This will display the Insert Function dialog box.

Insert Function

Search For a function:

Type a brief description of what you want to do and then Go
click Go
Cr select a category: [Most Recently Used j

Select a function:

MAX

SIN |
IF{logical_test,value_if_true,value_if_false)

Checks whether a condition is met, and returns one value if TRUE, and
another value if FALSE,

Help on this function oK | Cancel |

NOTE: To display the Insert Function dialog box you could have pressed the Shift+F3
key combination.

e Select the IF function, and then click on the OK button, which will display the Functional
Arguments dialog box for the IF function.

Function Arguments

IF

Logical_test || y =
Walue_if_true | E =
Yalue_if_False | E =

Checks whether a condition is met, and returns one walue if TRUE, and another walue if
FALSE.

Logical_test is any value or expression that can be evaluated to TRUE or FALSE.

Formula result =

Help on this function [o'4 | Cancel |
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Enter the required expression to be evaluated into the logical_test text area. Press the
Tab key.

Enter the required expression to be evaluated into the value_if_true text area. Press the
Tab key.

Enter the required expression to be evaluated into the value_if false text area and then
click OK.

Another example using the IF function

Look at the example shown below. In order to pass the average student mark must be
over 70%. The average grades are displayed in cell H8:H13

E3 Microsoft Excel - Working with Functions

File Edit Yiew Insert Format Tools [Data ‘Window Help carrecting ern
DEeEdem SRAY & RB-F - W = -2 A e -3
Brial -1z - BT U EE=EEH9 %, W% EE H-D-A-,

H27 - [

A B © D E F G H J

1
2
8
4
5
5 SUBJECTS
7 STUDENTS |Mathematics |English |History |Geography Average grades [Passed?
il Dave 68 78 59 59 66
9 Lou 69 69 69 67 69
10 Elliot 76 78 79 87 80
11 Rowan 67 86 58 65 69
12 Malcolm 85 77 87 78 82
13 Graham 59 68 78 89 74
14
15
16 To pass a student needs an average grade of over 70%

In cells 18:113 we need to display the word Pass or Fail, depending on whether the
average is over 70%. We first need to click on cell 18. Then we need to click on the
Insert Function icon. Next select the IF function within the Insert Function dialog box
and click on the OK button.

In the Logical_test section of the dialog box, we enter the logical test, i.e. H8>70

In the Value_if_true section of the dialog box, we enter the word Pass

In the Value_if_false section of the dialog box, we enter the word Fail

Click on the OK button to continue. Use the normal Excel drag techniques to extend this
function to the cells 19:113.

The results will be as illustrated.

SUBJECTS

STUDENTS |Mathematics |English [History |Geography Average grades |Passed?
Dave 68 78 59 59 66 Fail

Lou 69 69 69 67 69 Fail

Elliot 76 78 79 87 80 Pass
Rowan 67 86 58 65 69 Fail
Malcolm 85 77 87 78 82 Pass
Graham 59 68 78 89 74 Pass
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4.5.1 Numbers/Dates

To change number formatting
¢ You can quickly change the formatting of a cell or selected range by using the following

icons on the Formatting toolbar:

L~ Currency
23456 will become £23,456.00 (or your local currency equivalent)

NOTE: In the United States/Canada this icon may contain a $ symbol.

(=]
[ =]
_ Percent
.25 will become 25%

4 comma
12345 will become 12,345.00

+.0
00 Increase Decimal

23,456.00 will become 23,456.000

00

i Decrease Decimal
23,456.00 will become 23,456.0

4.5.1.1 Format cells to display numbers to a specific number of decimal
places, to display numbers with, without commas to indicate thousands.

To establish a fixed number of decimal places for cell formats

Select the cell, or range, you wish to format with a fixed number of decimal places.
To add a decimal point to the selection, click on the Increase Decimal icon on the
Formatting toolbar. You can continue to click to add as many decimals as required.

+.0 00
SO0 .0

To remove a decimal point from the selection, click on the Decrease Decimal icon on
the Formatting toolbar. Again, you can continue to click to remove as many decimals as
required.
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To apply comma formatting (to indicate thousands)

e Select the cell(s) containing the data which you wish to display with commas indicating
thousands. In the example shown, we have the number 1000000.

| 10000001
| |
e Click on the Comma Style icon

]

and the display will change as illustrated.

I 1,000 ,000.00 _I

4.5.1.2 Format cells to display a date style.

To format date styles
e Enter adate in a cell.
e Right click to display a pop-up menu, and select Format Cells, to display the Format

Cells dialog box. Select Date from the Category list and use the Type section of the
dialog box to select the required date format.

Format Cells

Tumber l Alignment: ] Font l Border ] Patterns | Protection ]
Category: Sample
General 02/01/1900
Mumber
Currency Tvpe:
Accountini
- *14 March 2001
L 14/03(2001
Perce_ntage 14j03j01
Fraction
s 14/3/01
Siientific
14.3.01
;e:Eial 2001-03-14 =
Clilstom J Locale (location):
|English (Urited Kingdarm) j
Date Formats display date and time serial numbers as date walues. Except for
items that have an asterisk {*), applied formats do not switch date orders
with the operating system.
(a4 | Cancel

4.5.1.3 Format cells to display a currency symbol.

To format cells using currency symbols
e Enter a number in a cell.
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e Right click to display a pop-up menu, and select Format Cells, to display the Format
Cells dialog box.

e Select Currency from the Category list and use the Symbol section of the dialog box to
select the required currency format. In the example shown, a EURO format has been
selected.

Mumbey ]nlignment ] Farit ] Border ] Patterns ] Protection]

Cakeqory: Sample
£2.00

Decimal places: |2 E|:

Symbal:

E [

Megative numbers:

£1,234.10

Special -£1,234.10
Custom J -£1,234.10 J

Currency Formats are used for general monetary values, Use Accounting
Formats ko align decimal points in & column.

Ok | Cancel |

e Select OK. An example is illustrated below.

2
[€3.00]

4.5.1.4 Format cells to display numbers as percentages.

To format numbers as percentages

e Click on a cell to select it and then click on the Percent Style icon on the Excel
formatting toolbar.

o Enter the percentage value into the cell.

NOTE: Formatting a cell using the percentage style, multiplies the value by 100 and
displays the results using a percentage symbol. Thus if you wished to use a value which
would display as 20%, you would enter 0.2 into a cell formatted this way.

0 .00
3% s lao su

'? Percent Skyle

20%

4.5.2 Contents
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4.5.2.1 Change cell content appearance: font sizes, font types.

To change text size

e Select the cell or range of which you wish to change the text size.
e Click on the down arrow to the right of the Font Size icon located on the Excel formatting

toolbar.

e Select the required font size.

E -

To modify the font type used by text
e Select the cell or range to which you wish to apply text formatting.
e Click on the down arrow in the Font section of the Excel formatting toolbar. Select the

required font.

E3 Microsoft Excel - Book7

Ble Edit ‘Yiew Insert Format  Tools  Data

DEEasy SRY & BBR-<

-0 - B F U

| % Arial

T Arial Black
Arial Namow

AvantGarde

T Book Antiqua

&8 Bookman

% Booliman Old Style

T Century Gothic

H% Comic Sans MS

& Courier

® Courier New
T Estrangelo Edessa

>

4.5.2.2 Apply formatting to cell contents such as: bold, italic, underline,

double underline.

To format text as bold

e Select the cell or range to which you wish to apply text formatting.
e Use the Bold icon located on the Excel formatting toolbar.

B

To format text as italic
e Select the cell or range to which you wish to apply text formatting.
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e Use the Italic icon located on the Excel formatting toolbar.

I

To format text as Underlined
e Select the cell or range to which you wish to apply text formatting.
e Use the Underline icon located on the Excel formatting toolbar.

u

To format text using double underlining

e Select the cell or range to which you wish to apply double underline formatting.

e To apply double underlining, then you must access the Font dialog box. To do this click
on the Format drop down menu and then select the Cells command. This will display
the Format Cells dialog box.

e Select the Font tab within the dialog box.

e Click on the down arrow to the right of the underline section of the dialog box, and then
select the required type of underlining, such as Double.

Format Cells E| E|

l Border ] Fatterns ] Pratection ]

Mumber ] Alignment

Font: Font style: Size:
|Arial |Regular |10
- g -
I Arial Black Ttalic 9
T Arial Narrow EBold
Bl fvantGarde ﬂ EBiold Ttalic J 11 j
Underline: Color:
|N0ne j | Autarnatic j I bormal Fant
Effects Preview
I strikethrough Undetline:
[ Superscript AaBbCoYyZz
I~ subscript: |N':'|-IE 7
This is a TrueType font, The same font will be used on both wour printer

and vour screen,
Double Accounting
oK I Cancel | = m

e Click on the OK button to close the dialog box. An example of this effect is illustrated
below.

y | Tuesday V

4.5.2.3 Apply different colours to cell content, cell background.

To change the colour used by the text

e Select the cell range which contains the contents of which you wish to change the colour.

e Use the Font Color icon located on the Excel formatting toolbar. Click in the down arrow
to display a range of colour options.
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A |-

~T— Font Color (Red) |‘

To change the background colour of a cell range

e Select the cell or range to which you wish to apply a different background colour.

e Right click on the selected range and select Format Cells. This will display the Format
Cell dialog box.

e Select the Patterns tab within the dialog box.

Format Cells

Mumber ] Alignment] Font ] Border |

Cell shading
Color:

Mo Color

EEEEEEER
EEEEEEEN
| B HEE
| N |
Sample
] | |
H N EEEN
Pattern: -

Ok | Cancel ‘

e Select the colour you wish to use for the cell background (be careful that you select a
colour which will allow you to still see the cell contents, for instance, do not select a dark
background, if you are using black as the cell contents colour!)

e Press the OK button when you have made your selections. An example is illustrated

below.

A | B
T
2| Mond;
_3 |Northern Sales 3
_4 |Eastern Sales 4
_9 |Western Sales 5
_6 |Southern Sales 6

7

4.5.2.4 Copy the formatting from a cell, cell range to another cell, cell
range.

To copy formatting using the Format Painter.

e Select some text which has been previous formatted.

e Click on the Format Painter icon. You will notice that the mouse pointer shape has
changed to the shape of a small painting brush.

FOR USE AT THE LICENSED SITE(S) ONLY
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com



PAGE 53 - ECDL MODULE 4 (USING MICROSOFT EXCEL XP) - MANUAL

<t

e Select the text to which you wish to copy the formatting, and when you release the
mouse button you will see that the formatting applied to the first block of text has been
copied to the newly selected text.

4.4.2.5 Apply text wrapping to contents within a cell.

To wrap text within selected cells

e Select the cell or range to which you wish to apply text wrapping.

e Right click and from the popup displayed select the Format Cells command.

e Click on the Alignment tab within the dialog box.

e Within the Text control part of this dialog box, select Wrap text, as illustrated.

Text control

-
[ Merge cells

e Click on the OK button to apply the text wrapping.
A 'before and after' example illustrates the effect.

Before

This line is just too long to fit into this little cell

After

This line
is just too
long to fit
inta this
little cell

4.5.3 Alignment Border Effects

4.5.3.1 Align contents in a cell range: left, centre, right; top and, bottom.

To align data within a cell range, to the left, to the right or to centre data
e Select the cell(s) you wish to align.
e Click on the Align Left icon to align data to the left.
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Click on the Align Right icon to align data to the right.

Click on the Centre icon to centre the data.

To align data between the top and bottom of a cell

Select the cell(s) you wish to align. From the Format menu, select Cells to display the

Format Cells dialog box.

To view the Alignment options, click on the Alignment tab at the top of the dialog box.
Choose the Top, Centre, or Bottom option in the Vertical area to align the data in the

cell.

Format Cells E| E|

Mumber  Alignment l Font ] Border ] Patterns ] Protection]
Text alignment Crientation
Horizonkal:

|General -

Wertical: i} =

|Bott0m -

Center -
Battom L.
Te: +

Distributed -

e
I shrink ko fit o E|. Degrees
™ Merge cells

Right-to-left

Text direction:

Conkext -

Cancel

Click on OK.

4.5.3.2 Centre a title over a cell range.

To merge and centre over arange

Lets say you had the following data within a worksheet.

A | B [ € ] 0 | E [ F [G]

|| || R —

IMnndaE _lTuesday Wednesday Thursday Friday

Now let's say that you wanted the word WEEKDAY, to be centred within the range C3 to

G3.
Enter the word WEEKDAY in cell C3 and press Return.
Select the range C3 to G3.
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e Click on the Merge and Centre icon, as illustrated.

The result will be as illustrated

E3 Microsoft Excel - Book7

File Edit View [Insert Format Tools Data  Window Help

et SRY taa-<¢ @ = -8 i
sl -0 - B ZUSE=SET %, W8
L~ A

A B c D E F G
1
2
3 WEEKDAY
4 Monday 'Tuesday Wednesd:Thursday Friday
=

4.5.3.3 Adjust cell content orientation.

To rotate text to any angle

o First select the cell(s) to which you wish to apply the rotation formatting.

¢ Right click to display the pop-up box, and from the list displayed, select Format Cells.
This will display the Format Cells dialog box. Select the Alignment tab.

e From the Orientation section either enter the exact amount of rotation required into the
Degrees box, or drag the Text dial to give the desired level of rotation.

e Select OK.

Format Cells

Mumber  Alignment l Font: ] Border ] Patterns ] Protection]

Text alignment Crientation

Horizontal:

|General ﬂ

‘ertical: i]

|Bott0m j

I~ .*
Text contral .

I wrap kext

I shrink to fit lﬂ—j| Deqgrees

™ Merge cells
Right-to-left

4 (v
N
4

B

Text direction:

Context -

Ok | Cancel

The effect is illustrated below.

A B c D E F G H

3 WEEKDAY
)
S
&\b@% bq;" gé\gob y @bzr @
4 & A & < &
B
B
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4.5.3.4 Add border effects to a cell, cell range.

To apply a border to a cell range (using the Border icon)

e Select the cell(s) to which you want to add a border.

e To view border options, click on the down arrow next to the Borders icon on the
Formatting toolbar.

B
B I
[
8 e

Draw Borders. ..

e Select the option you require. Once you have added a border using the Borders icon,
the border you selected will appear on the Borders icon. You can add the same border
simply by clicking on the icon after you have selected the cell(s) to which you wish to
apply the border.

To apply a border to a cell range (using the Format Cells/Border dialog box)

e You could select a cell, or range of cells, and then click on the Format drop down menu,
from which you can select the Cells command. This will display the Format Cells dialog
box.

e Select the Border tab, as illustrated.

Format Cells E| E|

Mumber ] Alignrment ] Font l Patterns ] Protection ]
Presets I
....... . Style:
Mone Qutline Inside | | - ——
Border o
=1 n L
Texk Text

EEI . . = Colar:

Automatic

The selected border style can be applied by clicking the presets, preview
diagram or the buttons abowve,

Ok I Cancel |

You can use this dialog box to apply borders and also to vary the type of border applied.
First choose a preset format to apply a border style.

Then click on the Border icons within the dialog box.

Finally use the Style and Color options to customise your borders.
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e Click on the OK button to apply the border formatting and close the dialog box.

To remove a border from cells or ranges

Select the cell(s) which contain the border you wish to remove. If you have a border
which appears to be on the left side of a cell, but may actually be on the right side of the
adjacent cell, select both of the cells.

To reveal the border options, click the arrow next to the Borders icon on the Formatting
toolbar.

Click on the first border option. This contains no border selection and all highlighted
borders will be removed.
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4.6.1 Using Charts/Graphs

4.6.1.1 Create different types of charts/graphs from spreadsheet data:
column chart, bar chart, line chart, pie chart.

To use the Chart Wizard to create a chart

Select the cells you want to include in a chart. If you want to highlight a non-contiguous
range, highlight the first range with the mouse, and hold down the Ctrl key and click on
any other cells.

On the Standard toolbar, click on the Chart Wizard icon.

zl 4?, 100%
‘EE 1 chart WizardP’

Step 1 of the Chart Wizard dialog box is displayed.

Chart Wizard - Step 1 of 4 - Chart Type

Standard Types l Custom Types ]

Chart bype: Chart sub-type:

Clustered Column, Compares values across
categories,

Press and Hold ko Wiew Sample |

Cancel | | Mext = | Finish |

From within the Chart Type section of the dialog box, select the required chart type, such
as column chart, bar chart, line chart or pie chart. In this example we have selected the
Column.

Click on the Next button.
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The next page of the Chart Wizard is displayed. You can make changes if required.

Chart Wizard - Step 2 of 4 - Chart Source Data E|Pz|

Data Range l Seties ]

&0
0
&0
50 O Davd
40 mlou
30
20
10
0
Mathematics Englizh Hiztary Geography
Daka range:
Series in: " Rows
&+ Calumns
@ Cancel | < Back | Mext = | Einish |

Click on the Next button. The next page of the Chart Wizard allows you to add items such
as chatrt titles, gridlines, etc.

Chart Wizard - Step 3 of 4 - Chart Options

i l Axes ] Gridlines ] Legend ] DataLabels | Data Table
Chart title:

Category [¥) axis: 0
&in
50 O Davd
Walue () axis: 40
,— 30
20
0
,— 0
s 3’-" 2 5
% &
\‘g’ls f
@ Cancel | < Back | MNext = | Einish |

You can make changes as required, and then click on the Next button.
The final page of the Chart Wizard is displayed. You would normally click on the Finish
button at this point to insert the chart as an object into your worksheet.

Chart Wizard - Step 4 of 4 - Chart Location

Place chart:

@ ascbjectini (e A - |
Cancel | < Back | | Einish |

The chart is displayed, as illustrated.
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E3 Microsoft Excel - USING CHARTS GRAPHS 01

File Edit View Inset Format Tools Chart  Window Help -8 X
DEEHLS8 SRAY L@ o a .
Arial -w - B I U H-2- e =
Chart Area - £ Chart Area - M - | B ([
A B c D E F L ki
1 EXAMINATION RESULTS =
2
3
4
5 Subject Dave Lou
6 |Mathematics 50 69
7 |English il 69 .
8 |History 59
9 [Geograph: 59 0
10 a0
11 70
12 60
12 el 0
14 m 40 mlou |®
15
15 30
17 20
18 10
13 0
20 Mathematics English History Geography
21 .

4.6.1.2 Add atitle or label to a chart/graph. Remove a title or label from a
chart/graph.

To add a title or label to a chart
e Click on the chart which you have created. You will notice that when the chart is selected
the drop down menus change:

E2 Microsoft Excel - USING CHARTS GRAPHS 01

File Edit Wiew Insert Format Tools Data  Window  Help

E3 Microsoft Excel - USING CHARTS GRAPHS 01

Eile Edit View Insert Format  Tools  Chart  Window  Help

l.e. the Data drop down menu is replaced by a Chart drop down menu.

e Click on the Chart drop down menu, and select the Chart Options command. Make sure
that the Titles tab is selected. Enter or modify a title as required.

Chart Options

Titles l Axes l Gridines l Legend l Data Labels | Data Table
Chart title:
Sales Figures Sales Figures
Category () axis: gg
|Regi0ns gg
Walue () axis: :g
Units Sold| )
0
0
& > & =
F & N o
7 & 4
\‘;7’; <FI
’— Regioas
@ oK | Cancel |

¢ In the example shown, we have added a title — Sales Figures
In the example shown, we have added a label for the X axis - Regions
In the example shown, we have added a label for the Y axis - Units Sold
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e Click on the OK button when finished.

Sales Figures

=

=S BD
w50 o Dave
mlou

B
[}
11

Mathematics English Histary Geography

Regions

To remove a title or label from a chart

Click on a chart containing a title or label which you wish to remove.

Click on the item, within the chart, which you wish to remove. In the example shown, we
clicked on the title.

=
%Sales Figures§
[

Press the Delete key to remove the title.

We could have used the same method to select and delete a label, for instance in the
example shown, we have selected the Y axis label.

4.6.1.3 Change the background colour in a chart/graph.

To change the background colour of a chart

Click once on a chart to select it.

Double click over a portion of the background of which you wish to change the colour.
This will display the Format Chart Area dialog box. If necessary select the Patterns tab
of this dialog box.
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Format Chart Area

H l Fant ] Properties
Border Area
(+ fwtomatic (" Aukomatic
" Mone " Mong
¥ Qi EEEEEENEN
ENEEEEEN
Shyle: -
| | EE
Colar: Automatic v | | |
ieight: -
™ shadow = @ &)
[ Round corners n EEER
Fill EFfects...
Sample
Ok | Cancel |

e Select the required background colour, and then click on the OK button.

4.6.1.4 Change the column, bar, line, pie slice colours in a chart/graph.

To change the colour of a column, bar, line or pie slice within a chart
e Click on the chart to select it.
o Click on the chart column, bar, line or pie slice to select it.

Sales Figures

@ Dave:
mLou

Mathematics

English

Regions

History Geography

e Double click over the selected item.

o From the dialog box displayed, select the Patterns tab, and then select the required
colour.
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Format Data Series E|E|
Patterns l Axis ] ¥ Error Bars ] Data Labels ] Series Order ] Options ]
Border Area
& pwtomatic " Automatic
" Mone " Mone
" Custom EEEEEEEN

ENEEEENEN
Style: -
| | Em
Color: Automatic - | | om
“Weight; -
| | |
[~ Shadow N EEEN
Fill Effects...
Sample

e Click on the OK button to apply your changes.

Sales Figures
Chart Area

an
a0
70 1

= &0

<

w50 0 Dave
£ 40 - mlLou

S a0 4
20 4
10 4

Mathematics English

Regions

History Geography

4.6.1.5 Change the chart/graph type.

To use the Chart Type icon

¢ Click on the chart to select it, and click on the drop down arrow next to the Chart Type
icon on the Chart toolbar.

"

¢ Click on one of the chart types which are displayed within the drop down menu. NOTE:
When wishing to convert to a Pie chart you have to use only one data series.

An example of the professional looking results which can be achieved is shown below.
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Sales Figures

40
30
20 Olast Year
10 B This Year
0 Last Year

Marth South East Wilest

Units sold

Regions

4.6.1.6 Duplicate, move charts/graphs within a worksheet, between open
spreadsheets.

To copy a chart within a worksheet

¢ Click on the chart which you wish to copy, so that small rectangular black selection
handles are displayed around the border of the chart. This indicates that the chart is
selected.

Sales Figures

linits sold
s EHEE
| %

¢ Click on the Edit drop down menu and select the Copy command.
Click elsewhere within the worksheet, click on the Edit drop down menu and select the
Paste command. You may have to move the chart to the required position.

To copy a chart to a different worksheet within a workbook

e Click on the chart which you wish to copy.

¢ Click on the Edit drop down menu and select the Copy command.

¢ Click on the worksheet tab of the worksheet to which you wish to copy the chart.

¢ Click within the selected worksheet and then click on the Edit drop down menu and select
the Paste command. You may have to move the chart to the required position.

To copy a chart to a worksheet within a different workbook

¢ Click on the chart which you wish to copy.

Click on the Edit drop down menu and select the Copy command.

Switch to, or open a second workbook to which you wish to copy the chart.
If necessary select the required worksheet within this second workbook.

Click on the Edit drop down menu and select the Paste command. You may have to
move the chart to the required position.
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To move a chart within a worksheet

Click on the chart which you wish to move.

Click on the Edit drop down menu and select the Cut command.

Click elsewhere within the worksheet, click on the Edit drop down menu and select the
Paste command. You may have to move the chart to the required position.

To move a chart to a different worksheet within a workbook

Click on the chart which you wish to move.

Click on the Edit drop down menu and select the Cut command.

Click on the worksheet tab of the workbook to which you wish to move the chart.

Click within the selected worksheet and then click on the Edit drop down menu and select
the Paste command. You may have to move the chart to the required position.

To move a chart to a worksheet within a different workbook

Click on the chart which you wish to move.

Click on the Edit drop down menu and select the Cut command.

Switch to, or open a second workbook to which you wish to move the chart.

If necessary select the required worksheet within this second workbook.

Click on the Edit drop down menu and select the Paste command. You may have to
move the chart to the required position.

4.6.1.7 Resize, delete charts/graphs.

To re-size a chart

Move the mouse to one of the corner selection handles (the small square black boxes)
and drag and drop. The chart is re-sized in the same way that any graphic is re-sized
within the Microsoft suite of applications.

To delete a chart

Click on the chart you wish to delete to select it and press Delete. The chart will be
deleted.
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4.7.1 Worksheet Setup

4.7.1.1 Change worksheet margins: top, bottom, left, right

To modify margin values

e Click on the File drop down menu and select the Page Setup command. This will display
the Page Setup dialog box.
e Select the Margins tab and modify your margins as required.

Page Setup
Page :l Header/Fooker ] Sheet ]
Top: Header: Print. ..
ks o s = o |
Prink Preview
Options. ..
Left: Right:
19 = 19 =
Boktom: Footer:
ks = [z =
Center on page
I Harizonkally I vertically
Ok I Cancel

4.7.1.2 Change worksheet orientation: portrait, landscape. Change paper
size.

To set orientation and page size

e Click on the File drop down menu and select the Page Setup command. This will display
the Page Setup dialog box.

e Select the Page tab. Select Portrait or Landscape orientation, as well as the desired
paper size.
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Page Setup EW@
Margins ] Header/Footer I Sheet ]
Prink...
I,
 Portrait £ Landscape Prink Preview
Scaling Options. ..
+ Adjust to:  |100 3: % normal size
" Fitta: |1 3: page(s) wide by |1 3: tall
Paper size: |A4 ﬂ
Print quality: 300 dpi |
First page number: Auko
Ok | Cancel

4.7.1.3 Adjust page setup to fit worksheet contents on one page, on a
specific number of pages.

To force a worksheet to print on a single page

e Click on the File drop down menu and select the Page Setup command. This will display
the Page Setup dialog box.

o Select the Page tab and modify the Fit to section of the dialog box to print on a single
page.
Scaling

" adjust bo:  |100 =3 % narmal size

* Fit ko liil pagefs) wide by |1 El: tall

4.7.1.4 Add, modify text in Headers, Footers in a worksheet.

To use standard headers and footers

o Excel provides standard header and footer options, which can be selected from the drop
down menus in the Page Setup dialog box. From the File menu, select Page Setup to
display the Page Setup dialog box. Make sure the Header/Footer tab is displayed.
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l Shest ]

Page ]Margins

Prink...
Print Preview
Header: -
|(none) j Opkions...

Custom Header. .. Custom Fooker. .. |

Footer:

|(n0ne) ﬂ

Ok I Cancel |

Click on the down arrow to the right of the Header list box to reveal a list of available
headers.

Click on the header required to select it.

Click on the down arrow on the right of the Footer list box to reveal a list of available
footers.

Click on the footer required to select it.

Click on OK to accept the header and footer and close the dialog box.

create custom headers and footers

From the File menu select Page Setup to display the Page Setup dialog box. Make sure
the Header/Footer tab is displayed.

Click on the Custom Header or Custom Footer button to display the Header (or
Footer) dialog box. In the Left section box, enter any data you want to appear at the left
margin of the header or footer. In the Center section box, enter any data you want to
appear at the centre of the header or footer.

In the Right section box, enter any data you want to appear at the right margin of the
header or footer. You can also add the date and time to your header or footer using the
Date and Time icons, include file and sheet names in the header or footer using the File
and Sheet name icons, and determine which pages the header and footer will appear on
using the Page buttons. When you have finished, click on OK to close the dialog box.
Your new header (or footer) will be displayed in the Page Setup dialog box in the
Header or Footer list box. Choose OK to close the Page Setup dialog box.

4.7.1.5 Insert fields: page numbering information, date, time, file name,
worksheet name into headers

To
[ ]

add page numbering to a worksheet

Click on the File drop down menu and select the Page Setup command.

Select the Header/Footer tab within the dialog box.

Click on either the Custom Header or Custom Footer, as required, and you will see
another dialog box displayed, as illustrated.
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Footer E|FZ|
Ta Farmat kext: select the text, then choose the Font buttan, ok
Taoinsert a page number, date, time, file path, filename, or tab name: position the

insertion point in the edit box, then choose the appropriate butkon, Cancel

Toinserk picture: press the Insert Picture button. To format wour picture, place the
cursar in the edit box and press the Format Picture butkan,

Al Blo| al8o] =%

Left section: Center section: Right section:

e Click within the section of the header or footer where you wish the page number to be
displayed, i.e. left, centre or right.
e Click on the Page Numbering icon.

e Click on the OK button, and then click on the OK button of the Page Setup dialog box, so
that all the dialog boxes are now closed.

TIP: To see your header/footer displayed on screen, click on the Print preview icon, to
view the worksheet as it would print.

To insert fields into a header or footer

e Click on the File drop down menu and select the Page Setup command.
e Select the Header/Footer tab within the dialog box.
e Click on either the Custom Header or Custom Footer, as required, and you will see

another dialog box displayed, as illustrated.

Footer E|E|
To format bext: seleck the text, then choose the Font button, ok
To insert a page number, date, time, file path, filename, or tab name: position the

insertion point in the edit box, then choose the appropriake button, Cancel

Tainsert pickure: press the Insert Picture button, Ta Format vour picture, place the
cursor in the edit box and press the Format Picture button.

Al 8lg] Blo| alnlol =2

Left section: Cenker section: Right section:

¢ Click within the section of the header or footer where you wish the field to be displayed,
i.e. left, centre or right.

e Click on the required icon.
il Font: Allows you to modify the font type and font attributes.

. .
Page Number: Inserts automatic page numbering
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Total Pages: Inserts the total number of pages into the footer/header. By using this
in conjunction with Page Number you can have a header which would, for instance,
display in the format Page 7 of 20.

Date: Inserts the current date.
@ Time: Inserts the current time.

]

—1File Name: Insert the name of the current workbook (i.e. file name).

=

—=1Sheet Name: Inserts the name of the current worksheet.

e When you have made your selections, click on the OK button, and then click on the OK
button of the Page Setup dialog box, so that all the dialog boxes are now closed.

4.7.2 Preparation

4.7.2.1 Understand the importance of checking spreadsheet calculations
and text before distribution.

Always check your work prior to sending it to someone else!

e Do not assume that Excel knows what you mean. If you enter the wrong data, then Excel
will use this data and produce incorrect information. You must ALWAYS check your
spelling and do a rough check that the calculations performed by Excel are as you
intended!

4.7.2.2 Preview a worksheet.

To preview a worksheet
e Click on the Print Preview icon within the Standard Excel toolbar.

[&

You will see a new toolbar displayed. Click on the Close button to return to the normal
Excel view of your data.

K3 Microsoft Excel - Book1

‘ | Prinl;...‘ §etup...| Margins| PageBreakPregiew| Close | Help |
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4.7.2.3 Turn on, off display of gridlines, display of row and column
headings for printing purposes.

To turn on (or off) the printing of gridlines

e From the File menu, choose Page Setup to display the Page Setup dialog box.

o Select the Sheet tab.

e To print gridlines make sure that the Gridlines check box (in the Print area of the dialog
box) is ticked. To turn off the printing of gridlines make sure that this option is not ticked.

Print

[~ Row and colurmn headings

lack and white Comrments: |(N0ne) j

Cell errars as: displayed A

I Draft quality

e Select OK.

4.7.2.4 Apply automatic title row(s) printing on every page of a printed
worksheet.

To control the printing of row and column headings

¢ From the File menu, choose Page Setup to display the Page Setup dialog box.

e Select the Sheet tab.

e To print row and column headings make sure that the Row and column headings
check box (in the Print area of the dialog box) is ticked. To turn off the printing of row
and column heading make sure that this option is not ticked.

Prink
[ aridines |7[:;§lnw and column headings:
| Black and white  Cotiments: ||{Nu:une]| ﬂ
[ Draft gualicy Cell errars as: lm
e Select OK.
4.7.3 Printing

4.7.3.1 Print a cell range from a worksheet, an entire worksheet, number
of copies of a worksheet, the entire spreadsheet, a selected chart.

To print a cell range from a worksheet
e Select the cell range which you want to print.
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e Click on the File drop down and select the Print command.
¢ Within the Print what section of the dialog box, click on Selection.

Print what
(" Selection (" Entire warkbaook,
(¥ Ackive sheet(s)

Click on the OK button.

To print the entire active worksheet

Click on the File drop down and select the Print command.
Within the Print Range select All, and in the Print What section, click on Active
Sheet(s).

Prink range

o

" Page(s)  From: 3: To: 3:

Prink what
(" Selection (" Entire warkbaook,
(¥ Ackive sheet(s)

Click on the OK button.

To print a specified number of copies of a worksheet

Click on the File drop down and select the Print command.
Within the Copies section of the dialog box, enter the required number of copies.

Copies

Mumbet of copies: ’iil

Ij;| Ijg| v Collake

Click on the OK button.

To print the entire workbook (including all the worksheets within it)

Click on the File drop down and select the Print command.
Within the Print what section of the dialog box, select the Entire workbook option.

Print what
" Selection
" Active sheet(s)

Click on the OK button.
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To print a selected chart
e Click once on a chart to select it.

e Click on the File drop down and select the Print command. You will notice that within the
Print What section of the dialog box, Selected Chart is active, as illustrated.

Print what
o L“'“

(+ Selected Chart

e Make any other changes as required from the dialog box, and then click on the OK
button to print the chart.

To print a spreadsheet to afile
o Click on the File drop down menu and select the Print command.
e Within the dialog box displayed, select the Print to file option.
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